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PRODUCTION MANAGER

Edit production times for completed nests

You can adjust the recorded elapsed time, operators, and operator times for nests that have been Completed.
This lets you edit logged times for a completed nest without changing its status and losing other cutting
information.

Set job status

Status can now be changed at the job level. This allows you to set all nests in a job to Pending or Completed
with a single click.

Search for nests by customer

You can search for nests by customer. All nests that contain parts assigned to that customer will be returned in
search results. The Customer keyword is now supported for nests.

Stopped time for machines

When a machine is Stopped, the time since it was last running is now displayed throughout the web app.
Production Managers and Operators can easily see how long a machine that is not cutting has been in that
state.

EDGE Connect Production Manager machines also show time Offline and time Unavailable.

Translation support

The web app is now available in 15 languages in addition to English.
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Unlimited Operator roles

The Operator role no longer requires a Production Manager license seat. You can set up and use an unlimited
number of operator accounts.

Automatically reconnect to a license

When a connection to a license is lost, ProNest Server will now automatically attempt to reconnect to the
license at a regular interval. The interval can be changed as needed.

DATA SYNC

Data Sync column names

Data Sync Plate Inventory mapping columns now match ProNest column names (Name and Stock No).

ProNest 2021 v14.2.1

SURECUT™ TECHNOLOGY

PlateSaver™ technology for Hypertherm XPR®

Designed specifically for use with the Hypertherm XPR plasma power supply and its advanced arc stabilization
feature, PlateSaver technology optimizes plate usage by using special and shorter lead-in styles and by
nesting parts closer together. Additionally, PlateSaver leads use a moving pierce that attempts to direct pierce
puddles toward the plate edge, previously-cut skeleton areas, or unused plate space.

The moving pierce creates a smaller and conical pierce puddle, called a Projected Splash Zone. Projected
Splash Zones can be modeled on the nest when a PlateSaver part is nested (View > Nest Image Objects >
Projected Splash Zones) and a nest processing routine, such as Cut Simulation, occurs.

Please contact Technical Support if you’d like to use this feature.
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Merging XPR setups for ProNest

When installing an XPR ProNest setup (.pn), if there is a previously-installed XPR ProNest setup from an
earlier version, ProNest can detect custom changes to Process Parameters or Bevel settings spreadsheets in
the old setup and merge them into the newer setup.

Benefits include:

l Customizations to Process Parameters or Bevel spreadsheets are not lost when a new setup is installed.
l Get the latest cut chart info and keep your existing customizations.
l Cut chart values from the cloud are used to compare customized setup against factory settings.
l Run on as many setups as you need.
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PRODUCTION MANAGER

Reorder the queue of pending nests

You can now easily change the order in which nests appear in the Pending queue for a machine. This can be
useful for scheduling production of nests.

l Drag and drop nests in any order you want.
l The Move to Top button bumps nests to the top of the queue.
l Anyone using the web app from any device can see the current order of the queue.
l A new permission to allow reordering of the queue is available for users with a Production Manager role.
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Search for nests by part

On the Nests page, you can now find nests by part name, work order number, or assembly name.

Part information by nest in the web app

Information about the individual parts on a nest is now available in various places in the web app.

Part images

Images of individual parts can be stored in the database and displayed in the web app.

Note: The Output Nest Images preference must be enabled to view part images in Production Manager.
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Part info for operators

Operators can view the parts on a nest from any machine-specific page by selecting a nest image and then
selecting the Parts tab. Part name, work order number, customer, and quantity nested are shown.

List of parts by nest

The nest detail page shows a list of parts that appear on that nest.
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List of nests for a work order

The work order detail page now shows every nest that the work order is nested on. In addition, Quantity
Nested and Quantity Cut are displayed by nest for the work order.

These two new values can be used to keep track of a work order’s progress as it is nested and cut.
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Completed nests by machine

On the machine-specific page, a new Completed tab lists completed nests that were run on that machine.

Leave completed nest cuts alone during re-output

Re-outputting any nest will not cause accrued time or operator info to be lost for any of its completed nest
cuts. If any nest cuts had their plate changed, that information will also be maintained.
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Machine Home visible on nest

To help operators determine how to load the plate on the cutting table, the machine home (init point) for a nest
is now indicated on nest images.

Mobile icon updated

The ProNest icon is now used for Add to Home Screen on mobile devices.

SOLIDWORKS® INTERFACE

Combining duplicate parts in different subassemblies

When a SOLIDWORKS assembly (.sldasm) contains different subassemblies that reference the same part,
that part is now added to the part list as a single part with the appropriate quantity. Previously, multiple
instances of the part were added to the part list.

DATA SYNC

Data Sync ERP number

When ProNest-assigned PlateID and ErpPlateNumber are provided in an inventory import, the
ErpPlateNumber for the plate can now be updated. (Originally introduced in Data Sync 14.2.0.)
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ProNest 2021 v14.2
v14.1.1–v14.2.0

PRODUCTION MANAGER

Redesigned UI

Both Production Manager and Production Kiosk have been completely redesigned and incorporated into a
single web-based user interface.

The responsive design allows for easy use on various types of devices, including touchscreens.



What's New in ProNest

Connectivity

Host the ProNest web app on-premises on a network server or PC. The web app will be accessible to any
device on your network, using either a wired or wireless (Wi-Fi) connection.

This means that you can use Production Manager from your cell phone, tablet, or laptop.

Benefits:

l Access ProNest production data easily in a web browser from any network-connected device.
l No installation is required on client devices.
l Mobile devices can connect wirelessly (Wi-Fi).
l Responsive design looks good on all types of devices (desktop, laptop, tablet, mobile phone).
l Browser-based client interface can be used on Apple® (iOS, macOS), Android™, Windows®, and so on.
l No Internet is required in order to connect.
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Dashboard

A new dashboard showing production stats and trends is now available in Production Manager.

Features include:

l Real-time view of machine activity and job status.
l View today’s progress against a 5-day average.
l Trends for completed work over the past two weeks.
l Work remaining shows pending work and estimated lead time.
l View machine status for all cutting machines in your organization.
l A machine page shows daily work completed and estimated lead times for each machine.
l View all open jobs in your organization.
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Operators

Assign an Operator role to any user. They will be able to log in, select from a list of pending nests, and run
those nests in Production Manager. Because Production Manager can be used on a mobile device at the
cutting machine, operators can easily start and stop nests as they are loaded and cut on a physical machine.

Production Manager can be set up so that operators see only a streamlined workflow for processing nests,
without any extra stats or analytics.

Operator activity can be tracked and viewed by date range, machine, and so on.

Search jobs and nests in Production Manager

In the web app, you can search for jobs that have been previously saved or nests that have been output. All
jobs and nests in the database can be searched, including jobs and nests created by other users on different
workstations.

You can search by a number of different fields to find the jobs or nests you need, such as job name, part name,
nest material, plate name, work order number, and so on.

Once you find the job or nest you need, simply click or tap to view details about it.
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Job information

The job detail page now provides more info, including an easy-to-read list of nests in the job, nest status, free
space for each nest, inventory plates used, and work orders nested.

If you are using Plate Inventory or Work Order Processing, select the link on the job page to open a detail view
for that item. The inventory plate detail page displays up-to-date plate quantity information, plate costs,
remnants created from the plate, and a list of nests that use the plate.
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The work order detail page shows work order details including due date and the jobs to which it is allocated.
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Nest information

The nest list lets you scan nests and see current status (Pending, In Production, Complete) and available Free
Space from the Nests page.

Click or tap a nest to view details about it, including estimated and actual production time, status for each copy
of the nest, operator and machine information, and more.
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EDGE Connect integration

You can add a direct connection to a Hypertherm EDGE Connect CNC. Real-time machine data from the CNC
are sent to ProNest and are available in Production Manager. This includes machine status and actual
production time.

Processing nests in Production Manager with an EDGE Connect CNC is fully automated. Production Manager
automatically tracks the progress of the nest as it is cut and shows the real-time status in the web app.
Because Production Manager is synched with the Start and Stop of the Edge Connect, status and production
times are very accurate for these nests.
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Swap the inventory plate for a nest after output

In Production Manager, you can replace the inventory plate used by a nest. This lets you quickly substitute a
different inventory plate for a nest that has already been output, without having to reopen the job and edit any
nests.

Replacing a plate in Production Manager ensures that plate tracking information is correct when a nest is cut
with a different inventory plate, such as when the original plate is missing or damaged.

Users and Permissions

Control user access to different areas of Production Manager using roles and permissions. Permissions for the
following can be granted at the user level:

l View production data
l Run nests in Production Manager
l Change nest status
l Swap inventory plates after output
l Undo output for nests
l Edit logged production times for nests
l Edit logged times for operators

WEB APP

Managing users

The web app has admin-only pages available for managing ProNest user accounts. Set up user accounts,
reset passwords, and add roles and permissions for different users.

Profiles

Users can set their own length precision and display units preference in the user profile area of the web app.

System Preferences

Several global preferences are now set in the web app and available for admin accounts. This lets you easily
set ProNest preferences for all clients sharing the same database.
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LEADS

Move and Lock Leads

Move and Lock Leads is a new option for placing and moving leads, where you can easily click on a part to
automatically place and lock leads. This is a quick alternative to having to manually unlock a lead, move the
lead, and then lock it again.

Move and Lock Leads is available once you enter Modify Leads mode from the Edit Part List, the main nesting
area, and Advanced Edit.

CAD IMPORT

Intentional open profiles

When importing a part, you can use the "Cut as open profile" CAD layer mapping option to treat profiles on that
layer as intentional open profiles in ProNest, which does the following:

l Does not apply kerf compensation
l Does not apply leads
l Does not display open profile warnings
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Any layers mapped to Cut as open profile must also be mapped to a cut process.

Note that profiles can be mapped to Cut as open profile, even if they are actually closed profiles. This feature is
designed for interior profiles.

Edit Part List speed improvement

Navigating to CAD files and folders in the Edit Part List Part Sources area is significantly faster, particularly
when navigating through network folders.
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Drag and drop to import parts

You can drag and drop parts from your desktop or Windows file explorer directly into the Part List area of the
Edit Part List window. This quick and convenient way to import parts is a helpful way to save time navigating
through folders in the Part Sources area. Drag and drop import is recommended only for parts that have
already been processed (such as token files) and for parts with import properties that don't need to be
adjusted.

DSTV powder marking

For powder marking, the PU bloc can now be mapped to the Scribe or Mark process of a ProNest machine.

Paging and filter box in the Work Order tab

Paging and a filter box are available in the Work Order tab of the Edit Part List.
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DISPLAY

Outline parts by profile type

Profile type is an outline option in the Color Legend. Using the Profile type outline option, part profiles are
identified as Exterior, Interior, Open, Special Open, Scribe, Punch, or Drill. Profiles mapped both to the Cut as
open profile layer mapping option and a cut process are identified as Special Open.

QUALITY

Quality enhancements

Quality has been improved, allowing finer control over applying and reapply quality to parts. Here's the full list
of quality enhancements in this release:

l Quality has its own Settings page, where you can specify a quality table, control when quality is automatically
reapplied, and define default quality settings for part import.

l Automatically apply quality to VSP, Pipe, CNC, and Part Library parts, when a quality table is specified. If quality
values are already contained in the CNC files or library parts, it will not be reapplied from the quality table during part
import.

l Reapply quality to parts by selecting the "Reapply Quality" button when right-clicking on a part. When used, quality
will be reapplied to parts when a quality table is specified and a record match is made.

DATA SYNC

Data Sync export file job name variable

JobID and JobFileName are now available as export file name variables. This allows job-level Data Sync export
tasks to create unique files by job. Refer to the Data Sync Help to learn more.
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Part Library Load Service updated

The Part Library Load Service is a utility for automatically adding new parts into the ProNest Part Library by
monitoring a user-defined folder and importing any DXF or DWG drawings found in the folder.

l The utility has been updated to work with ProNest 2021 and ProNest Server.
l Source parts can now differ by Customer, in addition to Name and Revision.
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EASE OF USE

Undo and Redo for nesting-related actions

Many actions performed on a nest can be undone or redone using Ctrl+Z for undo or Ctrl+Y for redo. As you
complete actions on the nest that can be undone or redone, you can also use the undo and redo drop-down
menus, located in the quick access toolbar in the top left corner of the ProNest window, to skip back or ahead
to a particular step.

Using undo and redo can be useful if you moved a part on the nest and want to move it back to its exact
previous position, for example.

Actions that can be undone or redone include:

l Manual and automatic nesting
l Dragging, rotating, and arraying parts
l Removing parts from the nest
l Bridging, chaining, and common line cutting parts
l Modifying the cut sequence
l Applying collision avoidance

If you wish to limit the number of undo and redo actions that ProNest keeps track of, you can do so by setting a
limit in Preferences > Miscellaneous > Maximum number of undo steps.
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MACHINE

Top, Bottom, Left, and Right Crop Extension settings

New Crop settings allow you to specify extensions of a particular length for your crop cuts at top, bottom, left,
and right plate edge locations. These crop extension settings allow the pierce points to move off the plate (a
positive extension) or onto the plate (a negative extension).

set_m_Crop.htm
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Height Sensing for Skeleton Cut-Up and Crop

In settings, you can enter a value for Height sensing distance, which can direct your cutting head to sense the
correct height at a specified distance from the plate edge for Crop and Skeleton line cuts. Contact Technical
Support if you'd like to use this feature.

Integrated cut sequence with parts for all vertical skeleton lines

When the setting to Integrate skeleton lines with parts is selected, an additional option to Include all vertical
skeleton lines may now be selected. When enabled, all vertical skeleton lines will be included in the integrated
cut sequence, even when the skeleton lines don't intersect nested parts.

set_m_SkeletonCutUp.htm
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One-Way Horizontal Cut Sequencing

The One-Way Horizontal cut sequencing (Settings > Cut Sequence > Type) option sequences parts in
horizontal bands in one direction.

Enable corner rounding Cutting Techniques for individual parts

When a Cutting Techniques spreadsheet is in use, Allow Corner Rounding is an available part property that
allows you turn on or off corner rounding on individual parts in the part list.

Learn more about rounding corners on parts

ADVANCED EDIT

Drag Leads

In Advanced Edit, you can click and drag a lead-in or lead-out to quickly change the size or angle of the lead.
This efficient and visual method of adjusting your leads is designed particularly for artwork pieces that may not
need leads in precise locations.

Dragging a lead to adjust the size and angle

part_CornerRounding.htm
advedit_DragLeads.htm
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Lead conflict view

When enabled in preferences, leads that cause a profile to be in conflict will be outlined in the Conflict color in
Advanced Edit, and a "Leads in conflict" warning icon will appear for the part in the Part List. Pierce size can
also be considered when determining conflict.

Advanced Edit speed improvement

Using a bevel setup and going into Advanced Edit for the first time is faster by 45% and subsequent opens are
85% faster.

BEVEL MACHINE INTERFACE

Bevel support for Class by Process

Class by Process-capable machine setups now support bevel class by process. On the Bevel Settings page,
you can specify an additional bevel settings table that is used to apply bevel parameters for the multiple cut
processes you have specified.

MISCELLANEOUS

User initials in naming variables

The initials of the current ProNest user can now be used in naming conventions for jobs, quotes, and other
areas. For instance, the job naming convention %JobID%_%UserInitials% for the user Bob Tiedt might yield a
job file called 215778_BT.nif.

materials_class_Multiprocess.htm
prefs_Naming.htm
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QUOTING

CSV quotes

CSV file is now an available format for quotes, in addition to print, PDF, and email. CSV quotes can be
configured using custom reports.

JOBS

All Recent jobs

On the File > Recent tab of ProNest, a new All Recents tab appears beside My Recents. All Recents shows
the latest 25 jobs that were saved in ProNest, which can be useful for shared database configurations.

Expanded options for reapplying leads when changing material

When the preference Always reapply leads when changing materials (File > Preferences > General) is
selected and material is changed at the job level, leads will be reapplied for all parts–now including nested
parts.

When this preference is cleared and material is changed at the job level, you can choose whether to reapply
leads for only nested parts, only non-nested parts, all parts, or no parts.

Note that changing material for individual parts in the part list has not changed. If at least one copy of a part is
nested, material for that individual part cannot be changed.

Search for Jobs

On the File > Recent tab in ProNest, you can now search for jobs that have been previously saved. All jobs in
the database can be searched, including jobs created by other users in a shared database environment. You
can search by a number of different fields to find the jobs you need, such as job name, part name, nest
material, plate name, work order number, and so on.

Learn more about searching for jobs

PROCESS

True Hole support for 220 Amp

True Hole® support for the 220 Amp plasma process is available. Please contact Technical Support if you’d
like to use this feature.

jobs_Search.htm


What's New in ProNest

DATABASE

Soft delete support

ProNest now has improved data integrity when you delete material, part library, assembly, plate inventory, and
work orders records from the database that may be referenced by other database records.

Soft deletion allows records to be marked as deleted without actually removing them from the database. Soft-
deleted records cannot be selected, but all old records can still refer to them. If the “deleted” record was not
referenced by any old records, then it will be permanently removed from the database.

Restore Tool for ProNest 2021 databases

A new database restore utility is installed with ProNest Server. This tool allows you to move a ProNest 2021
database to another PC with ProNest 2021, without having to use SQL Server Management Studio or other
tool.

PART LIBRARY

Part Library and Customers

Library parts can now be differentiated by Customer. It is now possible to have multiple library parts with the
same Part Name and Revision, but different Customers assigned. This is useful if you have a library part and
want to store separate versions of it for different customers.
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WORK ORDERS

Easier selection of library parts for work orders

In the Work Orders editor, selecting a library part is now easier when adding or editing a work order. This is
useful when you are linking work orders to library parts.

The new Library part selection list shows library parts with Name, Revision, and Customer.

Work Orders and Customers

When matching work orders to library parts, ProNest can now take customer into account when making a
match. If multiple library parts have the same Part Name and Revision, but differ by Customer, ProNest will
always try to match the work order to the library part that has the same customer.

This enables you to specify the customer for a work order in a Data Sync import task and match the correct
customer-specific library part during a sync.

PLATE INVENTORY

Plate display format

You can customize how inventory plates are displayed in ProNest. Plates can be formatted to use any
arrangement of plate name, heat number, ERP plate number, and ID.

See Regional preferences to learn more.

prefs_Regional.htm
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3D CAD

SOLIDWORKS® multi-body sheet metal support

All sheet metal bodies from a SOLIDWORKS multi-body SLDPRT file can be imported into ProNest. In the Edit
Part List, simply select the .sldprt file you wish to import, and select Contains multiple parts and Explode
multiple parts in the CAD Import Properties.

PLATE MACHINE INTERFACE

Plate Machine Interface (Peddinghaus)

For plates small enough that they wouldn't span two clamps, the second clamp can now be engaged or
disengaged based on plate size. A new CFF is required to use this feature.

FILE IMPORT

OMAX files

Support for OMAX .omx and .ord files is available, with an OMAX files filter option in the Part Sources area of
the Edit Part List. OMAX files are imported as CNC files and must use inch file units. Support for non-OMAX
.ord files is not available.

TRAINING

Training videos in the Help

To help you get up to speed on ProNest, the introductory training video series is now available directly in the
ProNest Help. Introductory LibreCAD training videos are also available in the LibreCAD Help. An Internet
connection is required in order to watch videos.

../../../../../Program Files (x86)/Hypertherm CAM/LibreCAD/doc/en-US/Default.htm
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CAD

LibreCAD for ProNest

A new Hypertherm-exclusive CAD program, LibreCAD for ProNest, is installed with ProNest. This dynamic
CAD program allows you to easily create drawings and edit drawings before and after they are imported into
ProNest for a streamlined workflow. LibreCAD for ProNest may used as a standalone CAD program or it can
be used for CAD cleanup in ProNest.

Once imported into ProNest, you can edit and dimension any file type in LibreCAD for ProNest. As a
standalone CAD editor, you can open DWG and DXF file types in LibreCAD for ProNest, but files must be
saved as DXF.

Key features in LibreCAD for ProNest include:

Export to ProNest

Import a drawing from LibreCAD directly into the Part List in ProNest without having to use the Edit Part List
window.

Edit Part List and nested parts

Edit an imported part from the ProNest Part List, the Edit Part List window, or the nest, even if the part is
already nested.

Multi-Select editing

For an efficient workflow, multi-select nested parts and right-click to Edit in LibreCAD so that you can edit
or dimension multiple parts in LibreCAD before returning to ProNest.

part_edit_cad_LibreCAD.htm
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Automatic Layer Mapping

The LibreCAD for ProNest Layer List is automatically populated from your Importing Parts Settings in
ProNest.

Trim Excess

Quickly trim away unwanted entities by selecting them in this mode.

Shape Text

Shape text around an entity to create signs and artwork.

Explode Text into Letters

Explode text strings into individual letters for fine-grain control when shaping text.
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Font Support

Use standard ProNest, Microsoft, and AutoCAD fonts in your drawings.

LibreCAD for ProNest Fonts

Use default LibreCAD for ProNest fonts or create your own LibreCAD font file (LFF).

Circle in Diameter

Draw a circle by entering a diameter value.

Contour Selection

Select an entity and hold the Shift key while hovering the mouse over other intersecting entities to highlight
and select a contour path.

Help system

Hover over buttons or use a tool and press F1 to get context-sensitive help.

Learn more about using LibreCAD for ProNest through training videos in the Knowledge Base.
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CAD Editor Preference

A new CAD Editor page is available in ProNest Preferences. On this page, you can specify a CAD program to
use when you need to modify drawings. LibreCAD for ProNest is the default CAD editor, but you can modify
this preference to use AutoCAD or any other CAD program installed on your PC.

Once a default CAD editor is set, you can edit a part in that program after it is imported into ProNest. This can
be done by right-click on the part and selecting Edit in… from the Edit Part List window, the Part List, and the
nest, even after a part is nested.

Raster Image Improvements

The raster image import feature now creates smoother curves and provides better results overall. You can
adjust the Color Threshold (helps create geometry based on differences in colors in the image) and Despeckle
(removes noise or speckles in the image) options during part import.

SVG File Import

You can now import SVG (scalable vector graphics) files into ProNest. Find these files more quickly using the
SVG option in the Files of type filter in the Edit Part List window.

REPORTS

Part Report

A new Part Report is available, allowing you to print information about a part or multiple parts by right-clicking
on the selected part(s) on a nest or in the part list, and selecting Part Report. The Part Report provides
information about an individual part, including an image of the part with display information such as
dimensions, size, material, class, process, costing information, and so forth. Ensure your Display Only
information is viewable in Report Options.

prefs_CADEditor.htm
raster_About.htm
svg_Adding.htm
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ADVANCED EDIT

Interior Bridge Cutting

In Advanced Edit, you can create interior bridge cuts with this new feature. Designed with sign-makers and
artistic crafters in mind, this feature allows you to create bridges to help minimize interior cutouts on parts for
aesthetic purposes and to reduce tip-ups.

MANUAL NESTING

Maximum Part Orientations to Try

This new setting allows you to try orientations of 90°, 45°, 30°, 15°, 5°, and 1° when manually nesting a part by
pressing Enter or double-clicking in the part list. The Automatic Nesting module is required to use this feature.

Disable Anchor Part to Cursor after Duplicate

A new preference is available to disable anchoring parts to the cursor after selecting Duplicate. This new
preference can be found here:

l File tab > Preferences > General tab > When duplicating parts, do not anchor to cursor.

When enabled, selecting Duplicate will place a copy of the selected part(s) slightly offset from the original on
the nest.

advedit_BridgeMode.htm
set_m_Nesting.htm
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MACHINE

Enhanced multi-process support

In ProNest, class is used to apply specific cutting parameters based on the consumables that will be used to
cut a part or nest. It is also used to apply performance applications (such as True Hole®) and other
technologies to parts.

For machines capable of cutting with different processes (such as combination plasma/waterjet tables), you
can now select a specific class for each individual machine process that is in use, with the class by process
feature. For instance, suppose the exterior edges of a part are cut with waterjet and the interiors are cut with
plasma.

When setting the material for that part, you can now select a waterjet class (which contains information about
orifice size, abrasive, and so on) and a separate plasma class (which contains information about amperage,
consumable set, and performance applications).

This feature offers greater control when setting cutting parameters for multi-process machines.

Additional benefits include:

l Default class can be specified for any process (not just limited to the primary cut process).
l Plasma setups with cut and mark processes can now have different classes set by process for a part.
l Part Library stores process-specific class information for library parts added from the Edit Part List.
l Class by process parts can be chained, bridged, or common line cut together if the exterior profile classes and

processes are the same.
l Easily change the class for a process on a part from the Edit Part List window or Part Properties.

Please contact Technical Support if you’d like to use this feature.

WORK ORDERS

Part Library matching

l When Part Library Matching is enabled in Work Orders Preferences, you can now right-click a part in the part list
and select Add to Work Orders. This is needed when reusing nests for different work orders (using job templates).

l When Part Library Matching is enabled in Work Orders Preferences, work orders that aren’t linked to library parts
can still be added to the part list. In Preferences, you can set ProNest to display a warning in this case, which will not
prevent the work order from being added to the part list.

materials_class_Multiprocess.htm
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COSTING

Allocated Costing

In the Allocated Part Detail report, the Material Cost is now more accurate for parts that are nested inside the
rectangular region of a larger part, but outside its exterior profile.

For the purposes of allocated costing, a part within the rectangular region of a larger part but outside its
exterior is no longer considered to be contained by the larger part.

BEVEL MACHINE INTERFACE

Bevel smoothing improvement

The Smooth Compensated Profiles setting creates a better fit-up, especially for thick material.

Disable Process Compensation on interiors

A new setting can be added to the CFG, allowing you to not apply bevel process compensation to interior
profiles.

DRILL MACHINE INTERFACE

Hole recognition

ProNest can now recognize drill geometry in CAD files where a hole is drawn as two arcs instead of a circle
entity.

PRODUCTION KIOSK

Refresh interval

Refresh interval has been added to Production Kiosk, to help resolve issues with slow refreshing of data.

Cut number of times

Production Kiosk now fully supports nests that are cut more than once.

PRODUCTION MANAGER

Cut number of times

Production Manager now fully supports nests that are cut more than once.

tooling_drill_DrawingInCAD.htm
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Prompt when changing nest status

When manually changing a nest status from Complete to Pending, the user is warned that cutting information
for the nest will be removed.

DATABASE

Data architecture

The ProNest database has been redesigned for improved accessibility, security, and data integrity.

l New browser-based interface to interact with database.
l Migrate data, even from a remote database on the network.
l Backup data from any local or network PC, then download the backup file (BAK) as needed.

Plate Inventory

Plate inventory quantity fields have been expanded to include more information, including

l Allocated quantity – See how many plates are used by different jobs.
l Cut quantity – Total number of plates that have been cut.
l Received quantity – Total quantity of plates that have ever been added.

Users and Permissions

The Users and Permissions feature has been completely redesigned to be seamless and easier to use for both
administrators and normal users.

With the feature on:

l User accounts can be set up by an administrator.
l Permission levels for various database-related operations can be set for each user.
l ProNest will remember user login credentials. You don't have to enter a username and password every time you

start ProNest.
l Log out at any time, if needed, to allow another user to log in (useful for multi-user PCs).
l All changes made by users (editing inventory, nesting, etc.) are tracked in the database.

Additionally, with the feature off:

l ProNest still automatically logs user data, based on the Windows user name. No login required.
l All changes made by users are tracked in the database.

Tracking and auditing

All changes in the database are tagged with Modified By and Date Modified information. For instance, you can
view all changes to nests made by a specific user in a specific date range.
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Assemblies

Revision is supported for an assembly, to help better organize assemblies that are similar to one another.

OPERATING SYSTEM

32-bit support ending

ProNest is now available only as a 64-bit application. This means that it will only run on 64-bit operating
systems.
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